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3D Railroad Concept And Design

WHAT ARE THE BASICS?

THE MOUSE
If you’re not already familiar with using a Mouse, get ready to grow an
appendage because, in working on your railroad plan, the Mouse is as vital as
your hands! You will use it to select, move, resize, draw and quickly access
dialog boxes.

The following is a summary of the ways 3D Railroad uses the Mouse to work,
but there are some terms you need to know before you can put the Mouse to
work for you.

• Clicking  simply means to press down and immediately release one of the
buttons located at the top of the Mouse.

• Double clicking is doing the same thing as clicking, only doing it twice.

• Dragging means to press and hold the mouse button down while you move
the Mouse. Note: To do this, you will be moving the Mouse around your
mouse pad. Don’t worry if you reach the edge of the pad … just lift the
Mouse up off the pad (continuing to keep the mouse-button down) and set
it back down in a new place that has room for you to continue moving it.

Now, for ways to use the Mouse:

Selecting objects and text: The Mouse is your control over the Pointer, a small
icon (often an arrow) on your screen. To select something, move the Selector
Arrow over the item you want to select, then click the mouse-button. Note: In
this manual, the Pointer is most frequently referred to as the Selector Arrow and
when you are typing text, it might also be called a Cursor.

Pointing: Move the Mouse to point the Selector Arrow or pointer at an object.

Moving: Once an object is selected, you can move it by dragging it to the
desired location.

Resizing: Once an object is selected, you can resize it by dragging on its
resizing control symbol. Depending upon the object you select, the symbol will
be a solid square, a hollow square, or a hollow circle. Note: See Selecting,
Resizing and Altering Objects in this section.
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Rotating: Once an object is selected, you can use the Mouse to rotate it. Note:
See Selecting, Resizing and Altering Objects in this section for specific
instructions.

Quickly accessing the Properties dialog box: To quickly access an object’s
Properties dialog box, click the right mouse-button on the object you want the
information for.

Drawing:  The Mouse “pointer” is used for drawing objects on the drawing
area. Note: Depending on the object to be drawn, the Mouse pointer may take
on the appearance of an arrow, cross-hair, pencil or other symbol. Please see the
What Are All Those Menus and Buttons? section.

KEYBOARD SHORTCUTS
The keyboard is essential for some actions (e.g. typing text) but, for some
operations, it can also be easier and faster to use than the Mouse. The following
is a list of keyboard “shortcuts” for some of those operations.

MENU KEYBOARD SHORTCUTS
Keyboard shortcuts are alternatives to using the Mouse. Note: Do not press the
+ sign, just press the two keys indicated.

Operation Key Strokes
New document Ctrl+N
Open file Ctrl+O
Save Ctrl+S
Print Ctrl+P
Undo Ctrl+Z
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Del
Group Ctrl+G
Ungroup Ctrl+U
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DRAWING KEYBOARD SHORTCUTS
Operation Key Strokes

Change Track Elevation CTRL+Left Mouse-Button while dragging circle
handles.

Constrain Straight Track SHIFT while drawing Straight Track

Keep Tool Caps Lock

Change 3D Object Height CTRL+Left Mouse-Button while dragging square
handles

Change 3D Bitmap Elevation CTRL+Left Mouse-Button while dragging square
handles.

MAIN MENU BAR
The strip at the top of the screen is called the “Main Menu.” The words on it —
“File,” “Edit,” “Tools,” “View,” “Arrange,” “Reports,” “Options,” Window,”
and “Help” — represent menus of commands. To open a menu, place the
Selector on the word for the menu item and press the mouse button.

Main Menu items open pull-down windows that contain commands.

• Commands followed by an ellipsis ( … ) means there is an additional
subwindow with special options or instructions.

• Dimmed (gray text instead of black) means command cannot be selected.

• Some commands are followed by a combination of keys (e.g. Ctrl+N).
These are called keyboard shortcuts and are alternatives to using the Mouse.
Note: Do not press the + sign, just press the two keys indicated.

STATUS BAR
The Status Bar, located at the bottom of the 3D Railroad window, provides a
wealth of information that is easily viewed at all times. It consistently displays
the type of tool you are using and its location on your plan. Then, depending
upon the type of tool you’re using, it will display a range of other information



10 What Are the Basics?

such as: object name, height, width, area, radius, angle, length, rotation angle,
object start-end location, object center, cursor location, grade, etc.

SELECTING, RESIZING AND ALTERING OBJECTS

CONTROL SYMBOLS
You will be seeing a lot of control symbols as you build your plan, so it is
essential you understand exactly what 3D Railroad control symbols are and
how to use them. Fortunately, the 3D Railroad symbols are few and are easily
understood and used.

In addition to the Selector Arrow, which is a part of almost all selection
activities, there are three other main groups of control symbols: squares, circles
and the “+” sign.

SELECTOR TOOL SYMBOL

3D Railroad’s Selector Tool Arrow looks and operates much the same as the
Windows® Selector Arrow. It, and an untitled plan window, appears as soon as
you open the 3D Railroad application.

If, after you are working on your plan, the Selector is not visible, you can
access it by either clicking on SELECTOR in the Tools menu or on the Selector
tool icon on the toolbar.

  

To use the Selector: Move the Selector over the object you want to select and
click. Small solid squares, called handles will appear when the object is
selected. Note: In the case of grouped objects, you may see one or more hollow
square handles. (How to use handles is covered in the “Square Symbols”
section later in this section.)
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You can now manipulate — move, resize, copy, cut, etc. — the object.

To select multiple objects: Hold down the Shift key as you point and click on
each additional object. Note: Another option is to:

1. Place your Mouse beyond the edge of all the objects you want to select.

2. Hold down the left mouse-button while dragging the Mouse across the objects.
All objects touched by the resulting dashed-line box will be selected.

3. Release left mouse-button.

To deselect an object(s) or text: Click on any unselected place on the plan.

SQUARE SYMBOLS

SOLID  SQUARE = RESIZE HANDLE

As was mentioned in the Selector section, when you select an object or text,
solid squares called resize handles appear at each corner of the selected item.
Use these handles to resize objects.

Note: Straight lines and tracks, curves, and grouped objects are exceptions to
this rule. Please refer to the “Circles” section later in this section or to the
individual object’s extended description in the What Are All Those Menus and
Buttons? section.

To resize an object: Click on any one of the resize handles with the left mouse-
button and drag the handle until you reach the desired size.

HOLLOW  SQUARE = RADIUS OR PROPORTIONAL  HANDLE
The hollow squares are used to change the radius of a curve or proportionally
resize a grouped object. They only appear when you select a section of curve or
spline track, a spline line or a grouped object.

To change the radius of a curve: After selecting the objects, drag the hollow
square inward or outward to make the radius smaller or larger. Note: You can
also alter the radius by dragging one of the two accompanying circles.



12 What Are the Basics?

To change the size of a grouped object: After selecting the group, drag the
hollow-square handle at the upper right corner of the group. Note: The handle
may appear at a different location if you have rotated the group.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

CIRCLE SYMBOLS

The circle symbols operate differently for each object.

CIRCLES = RESIZE HANDLES

Straight track or line sections:
The circles appear at each end of the track or line sections and are used to
lengthen/shorten the track or line.

To lengthen/shorten a track or line section: After selecting the track or line,
use the left mouse-button to drag the circle until you reach the desired length.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

POLYGONS

The circles appear at the ends of each side of the polygon and are used to
lengthen/shorten the side.

To lengthen/shorten a side: After selecting the polygon, use the left mouse-
button to drag one of the circles on the side you wish to lengthen/shorten until
you reach the desired length.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

CIRCLES = RADIUS HANDLES

Arcs; Curved Lines and Tracks; and Spline Lines and Tracks
The circles can be used to change the length or radius of a curve. They only
appear when you select a section of curve or spline track, or a spline line and
they are always accompanied by a dotted line.

To change the length or radius of a curve: After selecting the object, use the
Left Mouse-Button to drag one of the circles for the curve you wish to change
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until you reach the size you want. Note: You can also alter the radius by
dragging the accompanying hollow square.

Please refer to the individual object’s extended description in the What Are All
Those Menus and Buttons? section.

Round Boxes
The circles on a round box are used to alter the shape of its corners.

To alter the shape of a corner: When you select a round box, two circles
appear at each of its corners. Use the left mouse-button to drag one of the
circles. Note: All the corners will change at the same time.

THE “+” SYMBOL = ROTATE HANDLE

When you draw, place or select an object or text, a “+” symbol appears at some
point near the selected item. (Usually near a corner or the beginning or ending
point of a line.) Dragging this “+” allows you to rotate the object or text. Note:
You can also use the ROTATE items under the “Arrange” menu. Or, to rotate the
object around a selected origin point, use the ROTATE tool from the Toolbar.

ERASING OBJECTS

3D Railroad is an object-oriented drawing program. Unlike a painting program,
each thing you draw, whether a line, circle or rectangle, is a separate object.
This is an ideal environment for designing programs like 3D Railroad , which
must scale drawings and maintain a scaled relationship with real-world sizes.
But, since everything drawn is an object, it isn’t possible to erase — by rubbing
away or cutting out a piece as you can in a paint program — an object such as a
rectangle or any portion of it.

However, there are several ways you can simulate an erase.

ERASING A WHOLE OBJECT
The Selector tool lets you erase (actually delete) unwanted objects.

1. Activate the Selector tool — remember you can access it either through the
“Tools” menu bar or by clicking on its icon on the toolbar.
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2. Select the object(s) you want to remove.

3. Press the “Delete” key or choose CLEAR from the “Edit” menu.

For help with selecting, see Selecting, Resizing and Altering Objects in this section.

ERASING A PART OF AN OBJECT
You can achieve what looks like a partial erase in two ways; 1) resizing the
object or 2) drawing on top of the unwanted part of an object with another
white object.

Resizing an object. For example, if a line is too long, rather than erase the part
that’s too long, you can grab its handle and size it down. (Please refer to the
Solid Square = Resize Handle section earlier in this section.)

Drawing on top of an object. To erase part of an object with a white object:
Click the correct tool for drawing the desired white object over the unwanted
part of your object. Note: Please see the “Color” section of the properties dialog
box for the object you’re going to use as a cover.
Illustration: Portions of this circle and line have been erased by drawing over
them with a white oval, rectangle and line.

PROPERTIES DIALOG BOXES

Every object on your plan has a Properties Dialog Box that typically contains at
least three areas: 1) physical attributes of your object; 2) object information for
inclusion in the materials reports; 3) a selection bar that allows you to search
the files for different items, e.g. textures, patterns, 2D and 3D objects, etc.

All properties boxes can be accessed by clicking the Right Mouse-Button on an
object. However, each object’s box is unique to its type.
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USING COLORS AND PATTERNS
COLOR
Many of the Properties dialog boxes give you the option of selecting or
defining a color.

   

To select or define a color:

1. Click on the color bar and the Color dialog box opens automatically.

2. Click on your color choice.

3. If you don’t see the exact color you want, you can set a custom color:

• Click on “Define Custom Colors.”

• Click on the “Custom color” box you want to use to place your new
color in. Note: If you don’t click on this box prior to selecting your
custom color, your new color will automatically be placed in the first
box, overwriting any previous custom color you had placed there.

• WHEN YOU CLICKED ON THE EMPTY COLOR BOX, THE “SHADE

INDICATOR” ON COLOR BAR AT THE FAR RIGHT OF THE SCREEN

MOVED TO TOTAL WHITE. YOU MUST MOVE IT DOWN SLIGHTLY IN
ORDER FOR THE INDICATOR TO DETECT ANY COLOR.

• Either select your color choice by clicking on the shade in the rainbow-
colored Color Palette or

Set Hue, Saturation [Sat], Luminescence [Lum], Red, Green and Blue.
Note: You can observe your color changes in the “Color/Solid” box to
the left of your settings.

• Click on ADD TO CUSTOM COLORS.

• Click "OK" and the new color appears in the custom “Color” bar.
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PATTERNS

Pattern Check Box: When you click on this box, you will be able to select the
pattern color you want to apply to your object.

Pattern Color: Click on “Pattern color” and the Color dialog box opens
automatically. Note: To set pattern color, follow the same steps you took to set
the fill color.

Patterns: There are three methods for setting the pattern you want: using the
standard patterns, opening a custom pattern file, or designing a custom pattern.

Standard Patterns
Clicking on the empty circle next to “Patterns” activates the pattern
selection bar and gives you the choice of using any one of six standard
pattern designs.

Custom Patterns
Clicking on the empty circle next to “Custom” activates this option.
Clicking on EDIT opens the “Edit pattern” dialog box.
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• Click BROWSE to open/load a pattern from disk. Click “New” to create
or edit a pattern.

• Click “OK.” Note; If you created a new pattern, you are given the
opportunity to save it to disk for future use.

TEXTURES

It is possible to select/change the texture of many of the 3D Railroad objects.
When the dialog box opens for texture selection, review the list, then click on
the file you wish to use. There’s a wide range of textures to choose from, such
as grass, sand, dirt, and woodgrains, and they can displayed for you in the
preview box, immediately to the right of the file listings.

Note: What we refer to as roadbed texture is called ballast in hobby stores. With
3D Railroad, you not only have a variety of ballast textures to choose from, you
can also select track that has matching ballast between the rails and ties.

LINE STYLE AND LINE WIDTH
You have a choice of five line styles and widths. Note: Dashed or dotted line
styles can only be applied to the thin line sizes, they cannot be applied to the
widest sizes.
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ARROW STYLE, LENGTH AND WIDTH
You have a choice of three arrow styles lengths and widths. Click on the upside
down triangles immediately to the right of the arrow display boxes to make
your choices.

REPORTS INFORMATION SECTION
Report-information fields are a part of the majority of properties dialog boxes.
They include category, manufacturer, scale, type, name, part number, price, and
notes. There is also a “Show in report” check box. Note: If you want an object
included in the materials reports, you must click this box.

APPLY SETTINGS COMMANDS
These three (four choices with tracks) choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
to all items . Click on your preference
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OPEN FILE DIALOG

You have four choices:

1. Click on the upside down triangle next to the folder-name box to select
other areas of your disk.

2. Click on the first icon to the right of the folder-name box (a folder with an
up-pointing arrow) to view the next folder up the directory path.

3. Click on the second folder icon to create a new folder.

4. Click on one of the last two icons to select whether to view your options by
name alone or by a detailed information list.
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GROUP PROPERTIES

There are three specific group areas:

Price: Allows you to set your prices as either automatic or fixed. Automatic
calculates the group’s component objects’ total price. Fixed uses the price
specified for the whole group.

Allow group expansion in reports: If this option is enabled, you can double-
click grouped objects in the MATERIAL REPORTS DIALOG to list a group’s
component objects.

Use border: If you wish to use a border around your grouped objects, click
here. You also have the option of setting a color for your border. Please refer to
the “Using Colors and Patterns” in this section.

TRACK PROPERTIES

The Track Properties dialog box lets you specify a variety of parameters and
reports information related to track — Length, Radius(1), Radius(2), Start
angle, ArcDegrees, Grade %, Elevation1, Elevation2, Railspacing, Tie length,
Tie spacing, Track sep, Show axis, Show ties, Resizable option, Normal/Bridge/
Tunnel, Roadbed Width and Height, and Track and Roadbed Appearance.
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To access Properties: Click on the track, using the Right Mouse-Button and a
TRACK PROPERTIES DIALOG box appears.

Following is a description of each item in the Track Properties dialog:

Preview Box: Shows the selected/clicked piece of track. Changes you make to
the properties are also previewed here. Click “OK” to keep the changes, or
CANCEL to discard them, and exit the dialog.

Length: Shows the length of the selected track. In the case of straight track,
length can be entered here and the change will be applied to the track when you
click “OK.” Note: Though lengths are shown for other types of track, you
cannot change the length entry for them.

Radius(1): Shows the radius of curved track, and the first radius (the width
parameter) of oval track. If desired, you can specify a new radius and the
change takes effect when you click “OK.”

Radius(2): Shows the second radius (the height parameter) that’s used to draw
oval track (it’s set to zero in the case of curved track). Again, you can change
the radius and the change takes effect when you click “OK.”

Start angle: Shows the start angle of curved and oval track arcs.

ArcDegrees: Shows the length of curved and oval track arcs in degrees. Note:
The arcs extend counterclockwise from the start angle.
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Grade: Shows the percentage of grade change between the track’s start and
end. If the start and end elevations are the same, then the track is level and the
grade is zero.

Begin Elevation: Specifies the 3D elevation of the track’s start point. You can specify
track elevations, or you can hold CTRL and drag the circle handle — at the
track ends — to set elevations. Note: The preset amount is enough to elevate
the track to the top of the default roadbed height.

End Elevation: Specifies the 3D elevation of the track’s end point. Again, you
can specify track elevations here, or you can hold CTRL and drag the circle
handle at the track ends to set elevations. Note: The preset amount is enough to
elevate the track to the top of the default roadbed height.

Rail spacing: Shows the distance between the track’s rails. (This distance
changes depending on the train scale information in the reports fields. Note:
There is a train scale that can be changed [in the Metrics & Grid tab under
PREFERENCES on the “Options” menu] that affects the default spacing for this.)
You can also specifically enter a different spacing, as well as the rail color.

Tie length: Indicates the length of the track’s ties. (This distance changes
depending on the train scale information in the reports fields. Note: There is a
train scale that can be changed [in the Metrics & Grid tab under PREFERENCES

on the “Options” menu] that affects the default spacing for this.) You can also
specifically enter a different spacing, as well as the tie color.

Tie spacing: This shows the distance between the track’s ties. (This distance
changes depending on the train scale information in the reports fields. Note:
There is a train scale that can be changed [in the Metrics & Grid tab under
PREFERENCES on the “Options” menu] that affects the default spacing for this.)
You can also specifically enter a different spacing.

Number of rails: Sets your preferred number of rails.

Show Axis: Shows a blue axis line in the center of track, between the rails.

Show Ties: Shows/hides the track’s ties.

Resizeable: Indicates whether to allow the track to be resized.

Normal:  Set for normal track. Note: In the case of elevated track, the roadbed
is extended downward to the benchwork.
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Bridge: Overrides extending roadbed downward to the benchwork for elevated
track. This lets you create elevated track that floats so you can place hills, piers,
or other structures beneath it as supports.

Tunnel: Lets you specify track to be used for the inside of the tunnel.

Roadbed W/H: Sets the 3D width and height of roadbed.

Track:  When you click on the box immediately to the right of the track
selection box, the “Textures” folder opens for you to select the type of track you
prefer. When you’ve made your selection, click on OPEN and you return to the
Track Properties window. Note: All the track textures begin with the word
“Track” with the tie color and ballast type appended (e.g., TrackBrwTie Buff).
You will need to scroll to the right to see the track textures. Click a texture
name to see it in the preview box.

Roadbed: The current roadbed ballast texture filename is shown here. When
you click on the box immediately to the right of the roadbed selection box, the
“Textures” folder automatically opens for you to select the type of roadbed you
prefer. You can choose from a variety of ballast textures for the roadbed. Note:
All the ballast textures begin with the word “Ballast” with the ballast type
appended (e.g., Ballast Buff). This lets you easily match the ballast for the track
with the ballast for the roadbed (e.g., Ballast Buff matches TrackBrwTie Buff).
Click a texture name to see it in the preview box.

When you’ve made your selection, click on Open and your selections will be
entered and you will return to the Track Properties window.

Reports Information:  Sets the database information that appears in materials
reports. Enter the data as you would like it to appear in reports, and click on the
“Show in report” box. Note: If you want an object included in the materials
reports, you must click this box.

Show in report: Enable this option if you want the object and reports
information to appear in the materials reports dialog, and in material reports
printouts.

Apply settings to clicked piece only: Applies properties changes only to the
clicked piece of track, even if more than one piece of track is selected.

Apply setting to all selected: Applies properties changes to all selected track.

Apply settings to all: Applies properties settings to all track, selected or not.
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Apply settings as defaults: Uses the properties settings as track-tools defaults

More Button:  Click this button to set tunnel width, height, and texture of the
inside of the tunnel. If using single rail track, you can set the rail line width and
tie line width here as well.

SETTING  TRACK  ELEVATIONS  AND GRADES

In addition to using the Track Properties dialog box, you can also set track
elevations and grades by using the Set Selected Track Elevations and Chain
Track Elevations, found under the Tools, Track submenu, or by using their
icons on the toolbar.  For more information on these options, see the Tools
Menu section in the What Are All Those Menus & Buttons? chapter.

CREATING  A SPIRAL  HELIX  AND OTHER TRACK  PIECES

Creating a Spiral Helix and other difficult track pieces is as easy as the wave of
a wand with the Track Wizard.  This unique and easy-to-use tool allows you to
quickly create any type of track you need.  The Track Wizard can be found
under the Tools, Track submenu and it can be accessed from the toolbar by
clicking on the wand icon.

For more information on the Track Wizard, see the Track Wizard section in the
What Are All Those Menus & Buttons? chapter.

3D BITMAP PROPERTIES

Used to import a masked bitmap picture that will appear in the 3D view and to
set report fields and other properties for the picture.
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File name: Clicking on BROWSE automatically opens the folder “3DBitmaps”
for you to select a bitmap. There are several areas to this dialog box. Refer to
OPEN FILE DIALOG earlier in this section for more specific information.

Elevation: Determines the distance above the benchwork that the 3D Bitmap
will be placed.

Resizeable: Controls whether or not a bitmap can be resized once it’s placed on
your plan. Note: You can change this setting at any time by simply returning to
the Properties dialog box.

Show in 2D plan: Shows the bitmap in your 2D plan rather than an “X” box.

Hide cross-reference box when object is grouped: Draws a top view
representation of the bitmap using the draw tools. When enabled, you can group
the top view object with the “X” box and the “X” box will disappear, leaving
only your drawn object. Note: All of the provided bitmaps are trees, for which
2D top views have been created. To access these, use the library feature and
open libraries that begin with the word “trees.” This tool is only necessary to
customize a top view or create custom masked-bitmaps.

Apply settings commands: These three choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
all items. Click on your preference.

3D OBJECT PROPERTIES

Used to import a 3D studio or DXF object and textures. Set height, elevation,
report fields, cross-reference control and resizable option; and apply settings.
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File name: Clicking on BROWSE automatically opens the “Scripts” folder for
you to select an object from the 3D Studio files. There are several areas to this
dialog box. Refer to the OPEN FILE DIALOG information in this section.

Texture name: Clicking on BROWSE automatically opens the “Textures” folder
for you to select an object from the Bitmap texture files.

Once you’ve made your selections, you will notice that your 3D object and
texture selections are displayed in the preview window. The five large buttons
at the right side of the preview window have a direct effect on your 3D object.

Upward-Pointing Arrow Button: Proportionally enlarges your 3D object.

Downward-Pointing Arrow Button: Proportionally reduces your 3D object.

Preview: This button — toggling with the “Adjust orientation” button
immediately below it — controls the display of your object. In the “Preview”
mode, your object revolves, displaying all sides.

Adjust orientation: Stops your object’s rotation and freezes it to a front view.
Now you can move into the preview area, grab the object using the Left Mouse-
Button, and manually rotate it. Use SHIFT or CTRL to constrain rotation to the
X or Y axis only. To continue the object’s rotation, click on “Preview.”

Restore object: Restores your object to its original size.

Height: Sets the desired height of the 3D Object. Note: This is not a
proportional adjustment. Click on the “Restore object” button to return to the
object’s proportional height.
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Elevation: Determines the distance above the benchwork that the 3D Object
will be placed. Note: You can also CTRL+drag an object’s square handle in the
2D plan to change its elevation. In the 3D view, you can “right-drag” on an
object to change its elevation.

Resizeable: Controls whether or not an object can be resized once it’s placed
on your plan. Note: You can change this setting at any time by simply returning
to the Properties dialog box.

Show in 2D plan: This generates a wireframe view of your object and shows it
on the 2D plan. Note: The wireframes can be complex and draw very slowly, so
use this discretionally.

Hide cross-reference box when object is grouped: Select this option to draw
a top view representation of the 3D object using the draw tools. When enabled,
you can group the top view object with the “X” box and the “X” box will
disappear, leaving only your drawn object.

Apply settings commands: These three choices control which objects are
impacted by your settings choices, the clicked piece only, all selected items, or
to all items. Click on your preference.

2D OBJECT PROPERTIES

These set the line style, width and color of 2D objects. To access Properties:

1. Click, using the Right Mouse-Button, on the object. A dialog window with
two tab screen choices, Line and Fill appears.

Line Tab sets the line style, width and color; and lets you choose which objects
to apply the settings to. Refer to LINE STYLE AND LINE WIDTH, USING

COLORS AND PATTERNS, REPORTS INFORMATION, and APPLYING SETTINGS

earlier in this section for more specific information.
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Fill Tab sets fill and color, and pattern design. Refer to USING COLORS AND

PATTERNS under “Properties Dialog Box” in the What Are the Basics? section
of this manual for more specific information.

Fill Check Box: When you click on this box, you will be able to select the
color of the fill you want to apply to your object.

Pattern Check Box: When you click on this box, you will be able to select the
pattern color you want to apply to your object.


